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Emulation 

HGS UTS Screen 

A HGS Client window contains all the necessary controls to manage a host connection.  Controls are 
available to manage printer selection, user configuration management, screen font selection, last input 
recall and key macro recording.  There are also controls to perform print functions; Windows cut, copy and 
paste functions; standard UTS keystrokes for Message Wait, Keyboard Unlock and Transmit; etc. 

Using the Client Window 

Normally, the HGS Screen dialog will appear as a result of the user accessing the web page containing the 
embedded HGS Client object. 

Open Screen and Show Screen buttons on the object allow you to control the disposition of the client 
dialog or window. 

On the client window when multiple scr eens are open, you may use the Esc key to switch between 
screens.  Likewise, the Next Screen selection from the Window menu will switch between screens. 

The following is an explanation of each menu selection or control on the HGS Client window.  When 
shortcut keys are available, the key combination (e.g., Ctrl+L) is shown to the right of the menu 
selection. 

File menu 

The File menu contains controls to configure the appearance and behavior of HGS Client and to manage 
the print environment. 

Connect/Disconnect 

Use this toggle selection to connect to or disconnect from the host. 

Print Screen (All) 

Use this selection to print an exact image of the entire screen. 

Print Screen (UTS) 

Use this selection to produce the traditional UTS "Print Screen" operation.  The selection prints all 
the text from the previous SOE to the current cursor position. 

Close Print Ctrl+L 

Use this selection to end the print operation.  This selection only appears on the menu as a result 
of issuing a Print Screen command. 

Printer Setup… 

Use this selection to initiate the Windows Print Setup dialog where you may select an installed 
printer, change various properties of an installed printer, select paper size/source and page 
orientation. 

User Configuration Manager… 

Use this selection to open the HGS UTS User Configuration Manager.  This selection allows 
you to change the color settings, font and appearance in general of the opened screen.  You may 
also assign keystroke(s) to specific UTS and Windows operations, and create keystroke macros to 
perform repetitive tasks. 

Diagnostics 

Trace to Window 

Use this selection to initiate the client trace facility for the selected screen.  All 
communications between the client and the host will be displayed in a separate window. 

Note:  A right mouse click in the trace window will reveal a menu containing three 
selections that control the trace window: Stay on Top, Copy to Clipboard and Clear.  
Stay on Top controls whether the trace window remains on top (the default) of the 
emulator window during the trace, or remains in the background.  Copy to Clipboard 
may be used to copy the contents of the trace window to the Windows clipboard for 
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subsequent pasting into another Windows application (e.g., Notepad, WordPad, etc.).  
Clear may be used to clear the contents of the trace window. 

Trace to File 

Use this selection to initiate the client trace facility for the selected screen.  This 
selection is the same as Trace to Window except that the trace information will be 
written to a user-named file. 

Trace to Both Window and File 

Use this selection to initiate the client trace facility for the selected screen.  This 
selection is a combination of the two selections above. 

Clear Trace Window 

Use this selection to clear the trace window and/or file without terminating the trace.  
This selection appears after a trace has been initiated. 

Close Trace 

Use this selection to close the trace window and/or file and terminate the trace. 

FCC Map 

Use this selection to display an FCC Map.  Use only at the request of KMSYS Worldwide, 
Inc., support personnel. 

Control Page 

Use this selection to display the contents of the UTS Control Page in the trace window 
and/or file. 

Note:  The last four selections only become visible once the trace has been started. 

Transport Trace 

Use this selection to initiate the highest trace level, a trace that monitors all activity 
between the client and the host for all open screens. 

Close 

Use this selection to break the host connection and terminate this HGS32 window. 

Edit menu 

The Edit menu contains controls to manage selected text between the screen and the Windows clipboard. 

Cut (Ctrl+X) 

Use this selection to remove the currently selected data from the document and put it on the 
clipboard.  This command is unavailable if there is no data currently selected. 

Cutting data to the clipboard replaces the contents previously stored there. 

Data may be selected by placing the mouse cursor at some point on the screen, and holding 
down the left mouse button, drag the mouse cursor to any other location on the screen.  Upon 
releasing the left mouse button, the data will be selected. 

An alternate form of selection is with standard, keyboard key sequences.  With the mouse or 
arrow keys, place the screen text cursor at some point on the screen and use any of the following 
key sequences to highlight the data being selected: 

Shift+Home selects everything from the cursor position through column one of the 
same row. 

Shift+End selects everything from the cursor position through the last column of the 
same row. 

Shift+Right Arrow extends/contracts the selection to the right. 

Shift+Down Arrow extends/contracts the selection down the screen. 

Shift+Left Arrow extends/contracts the selection to the left. 

Shift+UP Arrow extends/contracts the selection up the screen. 
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Copy (Ctrl+C) 

Use this selection to copy selected data onto the clipboard.  This command is unavailable if there 
is no data currently selected.  Note: Copying data to the clipboard replaces the contents 
previously stored there. 

Paste (Ctrl+V) 

Use this selection to insert a copy of the clipboard contents at the insertion point.  This command 
is unavailable if the clipboard is empty. 

Hint:  Use a right-mouse click anywhere on the screen to reveal an editing popup menu containing 
selections for the most commonly used functions. 

Input Recall 

Use this selection to initiate the Input Recall window.  This selection allows previous lines 
transmitted to the host to be recalled and retransmitted. 

View/Edit UTS Control Page 

Use this selection to edit the UTS Control Page. 

Macros menu 

The Macros menu is used to control the key macro recorder and to provide access to macros placed for 
selection on the menu. 

Run 

Use this selection to drop down a list of user-created key macros. 

Start Recorder 

Use this selection to begin the Key Macro Recording (Note: A recorder icon will appear in the 
status line at the bottom of the window signifying that the recorder is active).  All keystrokes 
entered will be collected until the recording is terminated with the Stop Recorder selection. 

Stop Recorder 

Use this selection to terminate the macro recorder.  Upon making this selection, the Save Key 
Macro dialog will allow the macro to be named and saved. 

View menu 

The View menu contains controls that toggle the display of toolbars and control characters. 

Function Key Bar 

Use this selection to toggle the display of the UTS Function Key toolbar. 

Tool Bar 

Use this selection to toggle the display of the HGS Client Toolbar. 

Macro Bar 

Use this selection to toggle the display of the Key Macro toolbar. 

Show Control Characters 

Use this selection to toggle the display of control characters (Tab, Form-Feed, Line-Feed, etc.). 

Show Inactive Page 

Use this control to toggle the inactive screen page display.  When checked along with the screen-
paging feature enabled, the last screen page will be shown in an inactive screen page window 
located in the lower half of the screen window.  This feature allows you to view the results of a 
transaction or program in an inactive, read-only, pane of the window while executing another 
transaction in the active portion of the window.  The inactive pane is always shown in black on 
white.   

If there is more than one active screen page configured, clicking the gray separator bar causes 
the inactive screen page display to scroll to the next inactive screen page (notice that the current 
active page is never shown in the inactive pane). 
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When using this option, the screen window may have to be resized manually to accommodate the 
dual screen display. 

Note: The inactive page will not appear until the user does the first Page Down or Page Up. 

WARNING:  The host is completely unaware of the paging feature.  Applications, especially DPS, 
often check the screen input for exact text — meaning the application expects specific text to 
appear at specific locations on specific screens.  Use of the Page Down and Page Up keys with 
this feature can leave the screen in a state not expected by the application. 

Screen Font Settings… 

Choose this selection to change or view screen font settings. 

Window menu 

The Window menu selections are used to navigate between screens. 

Next Screen 

Use this selection to switch to the next available screen. 

Previous Screen 

Use this selection to switch to the previous screen opened. 

Screen List 

To switch to another screen, select from this list of configured screens.  You may also switch to 
another screen by selecting, with the mouse, the appropriate tab at the bottom of the window. 

Help menu 

Use this selection to display the Help menu. 

Contents 

Use this selection to get help for HGS Client and display the Contents topic.  All on-line help may 
be reached from this topic. 

This Window 

Use this selection to get help on the client window. 

About 

Use this selection to display version and copyright  about HGS Client. 

The buttons 

Configuration and Diagnostics 

Click this button to reveal the Configuration and Diagnostics Menu. 

User Configuration Manager 

Use this selection to open the HGS UTS User Configuration Manager.  This selection 
allows you to change the color settings, font and appearance in general of the opened 
screen.  You may also assign keystroke(s) to specific UTS and Windows operations, and 
create keystroke macros to perform repetitive tasks. 

Diagnostics 

The options available on this drop-down menu are the same as those shown for 
Diagnostics under the File menu, mentioned above. 

Print 

Use this selection to display the Print menu. 

Cut (Ctrl+X) 

Use this selection to remove the currently selected data from the document and put it on the 
clipboard.  This command is unavailable if there is no data currently selected. 

See also, Cut on the Edit menu, shown above. 
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Copy (Ctrl+C) 

Use this selection to copy selected data onto the clipboard.  This command is unavailable if there 
is no data currently selected.  Note: Copying data to the clipboard replaces the contents 
previously stored there. 

Paste (Ctrl+V) 

Use this selection to insert a copy of the clipboard contents at the insertion point.  This command 
is unavailable if the clipboard is empty. 

Input Recall 

Use this selection to initiate the Input Recall window.  This selection allows previous lines 
transmitted to the host to be recalled and retransmitted. 

Screen Font Adjustment 

Choose this selection to change or view screen and font settings . 

Keyboard Layout 

Use this selection to display the Keyboard Layout window. 

Key Macro Menu 

Use this selection to drop down the Key Macro menu. 

UTS Message Wait Key 

Use this selection to issue an UTS Message Wait. 

UTK Keyboard Unlock Key 

Use this selection to unlock the keyboard. 

UTS Transmit Key 

Use this selection to issue an UTS transmit to the host. 

Help 

Use this selection to display the Help menu. 

Contents 

Use this selection to get help for HGS Client and display the Contents topic.  All on-line 
help may be reached from this topic. 

This Window 

Use this selection to get help on the client window. 

About 

Use this selection to display version and copyright  about HGS Client. 

Input Recall window 

HGS Client saves single-line messages sent to the host system when you press the transmit key.  A 
maximum of 200 of the most recent messages is saved.  You can display a list of these messages from 
the Edit, Input Recall menu selection. 

Paste 

When this list is displayed in the Input Recall window, you can view the entries and optionally 
select an entry to be "pasted" onto the current screen when the Paste button is pressed. 

Transmit 

The Transmit button performs the same operation as the Paste button, but also ends by 
transmitting to the host (double clicking on the entry also performs the paste-and-transmit 
operation). 

Close  

Use this button to close the Input Recall window. 
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 Keyboard Layout 

This window displays all the standard UTS keys and their corresponding keyboard keystrokes.  Any UTS 
key may be issued by selecting the keystroke from the list box and pressing the OK button. 

Type Search String 

To locate the keystroke in the list box more quickly, type the first few characters of the keystroke 
name in the Type Search String list box. 

OK 

Click this button to execute the selected keystroke and return to the HGS Client screen window. 

Cancel 

Click this button to cancel any selected keystroke, close the window and return to the HGS Client 
screen window. 

 Adjust Screen Font 

This window contains controls to change the appearance of the UTS HGS Client screen. 

Available Screen Fonts 

From this drop-down list box, select a font from the list of fonts installed on your system.  The 
window/screen size will automatically be adjusted depending upon the font selected. 

Bold 

Check this box to increase the intensity of the selected font. 

Note:  The next four buttons will only be visible when the auto-scale mode is not Font to Screen 
(see Appearance). 

Save 

Use this button to save the changes made to the screen. 

Close 

Use this button to close the Screen Font Sizing/Spacing window. 

 

UTS Control Page View/Edit 

This dialog may be used to edit the UTS Control Page and for performing control page file transfers. 

Note: Only the controls that may be set from the PC are enabled (see below): 

XMIT 

UTS emulation provides three modes of transferring data from the terminal screen to the host processor: 
VAR (Variable), ALL, and CHAN (Changed).  The current transmission mode is set in the XMIT() field 
in the terminal control page.  Most host programs expect the terminal to be operated in the VAR transmit 
mode. 

OK 

Click this button to accept any changes made in this window and close the window. 

Cancel 

Click this button to discard any changes made and close the window. 

Help 

Receive on help for this window. 
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Configuration 

HGS UTS User Configuration Manager 

The HGS UTS User Configuration Manager dialog contains configuration controls to maintain the 
appearance and functionality of the HGS Client environment 

Basic Terminal Settings 

The controls in this group affect the general behavior of the terminal. 

Initial Transmit Type 

UTS emulation provides three modes of transferring data from the terminal screen to the host 
processor: VAR (Variable), ALL, and CHAN (Changed).  The current transmission mode is set in 
the XMIT() field in the terminal control page.  Most host programs expect the terminal to be 
operated in the VAR transmit mode.  If your application requires an initial mode other than VAR, 
set it here and HGS Client will initialize the XMIT() field with that value. 

Print Time-out 

Use this text box to specify how long the emulator will wait for additional print data before 
automatically closing the printer.  The default is 15 seconds. 

-1 (or any negative value) = No timeout,  
0 = Timeout immediately after printing,  
n (any positive number) = Timeout n seconds after printing. 

Screen Pages 

In this text box, you may specify from one (default) to nine screen pages for each UTS screen.  
In conjunction with the paging feature, the PAGE DOWN and PAGE UP UTS keys are mapped to 
the Page Down and Page Up keyboard keys, respectively. 

Paging is most useful where only one screen is available.  Paging provides the means to maintain 
multiple output screen pages for reference while running additional transactions. 

WARNING:  The host is completely unaware of the paging feature.  Applications, especially DPS, 
often check the screen input for exact text — meaning the application expects specific text to 
appear at specific locations on specific screens.  Use of the Page Down and Page Up keys with 
this feature can leave the screen in a state not expected by the application. 

Also see, Show_Inactive_Page. 

Screen Options 

The controls on this tab govern general screen appearance. 

Force UPPERCASE 

Checking this box causes HGS Client to translate lower case characters that are typed to 
their uppercase equivalents. 

Blinking Cursor 

Checking this box causes the current cursor position to blink.  If this box is not ch the 
cursor remains solid. 

Text-only Blink 

Check this box to blink only the text of the UTS blinking character instead of the text 
and background.   

 Mapper Look 

Check this box to set HGS Client for "Mapper Look and Feel" processing.  With Mapper 
Look checked, four of the display characteristics of HGS Client change: 

1. If a line contains an ASCII Tab Code in the first column, that line is considered 
a "Tab Line".   Tab codes are displayed using the graphic vertical bar (|) that 
produces a visual column separator for your report. 
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2. The only control characters displayed will be the Start-of-Entry (SOE), the 
standard Tab Code, and the Mapper Tab Code.  Characters such as Form-Feed 
and Line-Feed are displayed as spaces. 

3. A protected field (function key name on the last row of the Mapper screen) can 
be transmitted by clicking with the mouse.  This is compatible with the function 
key lines produced by Mapper 2200 level 35 and higher. 

4. HGS Client will also support special Mapper box drawing sequences sent from 
the host. 

Note: When Mapper Look is used, the Mapper station must be configured as a 
terminal type "PCE" with an option of "S" (Mapper Look and Feel), or as a terminal 
type of "6S". 

Configuration Actions 

Use the buttons in this group to configure the individual features of this product. 

Screen Appearance 

Click this button to reveal the controls used to alter the appearance of the screens (see 
Appearance). 

Keyboard Layout 

Click this button to reveal the controls used to configure keystrokes for special UTS and Windows 
functions (see Keyboard). 

Printers  

Click this button to reveal the controls used to configure printers (see HGS UTS Printer 
Configuration). 

Macros  

Click this button to reveal the controls used to configure key macros that perform a series of 
keystrokes (see Macros). 

Application Scheme 

Click this button to configure the general appearance of the HGS Client software. 

eXpress Custom Terminal Screen Appearance 

The eXpress Custom Terminal Screen Appearance window contains configuration controls to change 
screen fonts and to apply colors to specific areas of the display. 

Screen Color Settings 

The Screen Color Settings group contains controls that may be used to change the foreground and 
background color of various UTS screen attributes. 

Select Color for Attribute 

From this group, select an attribute option button whose color is to be changed.  When an 
attribute’s colors are changed, those colors will be applied to all areas of the screen having that 
specific attribute.  An attribute’s colors consist of a foreground (text) color and a background 
color. 

Choose Foreground (text) Color 

To change the text color of an attribute, first select the attribute from the Select Color for 
Attribute option group.  Next, select a color from this drop-down list box.  If you do not wish to 
use one of the standard Windows colors, select Custom at the bottom of the list and configure 
the desired color with the standard Windows Color dialog. 

Choose Background Color 

To change the background color of an attribute, first select the attribute from the Select Color 
for Attribute option group.  Next, select a color from this drop-down list box.  If you do not wish 
to use one of the standard Windows colors, select Custom at the bottom of the list and configure 
the desired color with the standard Windows Color dialog. 
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Edit Palette 

Click this button to edit the screen color palette. 

Use UTS60 Colors 

Check this box to use UTS60 colors as set by the host program.  Only valid if the Terminal Type 
selected is UTS60. 

Always Use Low Intensity for UTS60 Background 

For better contrast, check this box to use low intensity color for UTS60 background color. 

Screen Font 

Use the controls in this group to change the screen font, intensity, size and character set. 

Font Name 

From this drop-down list box, choose the desired font. 

Bold 

Click this button toggle to increase or decrease the intensity of the selected font. 

Font Size 

Use this spin box to increase or decrease the size of the selected font. 

Character Set 

Use this drop-down list box to change the character set. 

Automatic Font Scaling 

These three options control how the emulator will behave when you size a station window or change the 
screen font. 

None 

When the None option is set, no screen or font scaling will be performed when the screen 
window is resized. 

Screen to Font 

The Screen to Font option causes the screen window size to be changed automatically when the 
screen font size is changed.  Consequently, the station window size may be changed without 
altering the size of the font.  If the size of the window is made larger than that necessary to 
accommodate the screen size, a dotted line will show the physical limits of the screen.  If the 
window size is reduced below the physical screen size, scroll bars appear allowing access to those 
parts of the screen not currently visible.   

Font to Screen 

The Font to Screen option causes the font size to change automatically whenever the window 
size of the station is altered.  For example, if a window is enlarged or made smaller, the font will 
increase or decrease in size, accordingly.  The Font to Screen option will only work when using 
a scalable font (e.g., Courier New, Lucida Sans Typewriter, etc.). 

Default 

Use this button to restore the defaults. 

Import 

Click this button to import an existing appearance settings file. 

Export 

Click this button to export the appearance settings to a file. 

 

Edit Screen Color Palette 

This dialog allows the editing of the supplied standard 16 colors.  To edit, select a color in the Color 
Palette list and click the Edit Selected button.  You may also double click a color in the list. 
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Color Palette 

Select a color from this list and click the Edit Selected button. 

Set to Default 

Click this button to reset to all the default colors. 

eXpress Custom Keyboard Layouts 

This window is used to define which Windows keyboard key or key combination will be used to initiate a 
UTS terminal or HGS Client emulation specific action.  Use this window to customize the keyboard to meet 
your specific needs. 

Graphic Keyboard 

The graphic keyboard display illustrates the configured key or key combination associated with a terminal 
key.  Note: The location and arrangement of the keys on the graphic keyboard may not match the exact 
layout of your keyboard; however, most keys on your keyboard should have its corresponding key 
represented on the graphic keyboard.  After selecting a key name from the Key Actions and Key 
Sequence Assignment list, the configured key or key combinations will appear as if they have been 
pressed.  You may change (redefine) or add additional key combinations by pressing the key(s) on the 
graphic keyboard with a left mouse click.  Valid key combinations are any single key, or a single key plus a 
combination of one or more of the optional, Shift, Alt and Ctrl keys.  When the desired key combinations 
have been selected, press the Set Key Assignment button to assign the key. 

Note:  Pressing the Num Lock key on the actual keyboard will cause the Num Lock display on the 
graphic keyboard to toggle (ON/OFF) and the captions on the faces of the numeric keypad keys to change 
accordingly. 

The extended keys (see below) are not mapped to any key in the Key Actions list for the default 
keyboard layout file.  They may, however, be mapped by the user to any key in the Key Actions list.  If 
they are not mapped, their behavior will be the same as their counterparts on the numeric keypad and 
main keyboard. 

For enhanced 101- and 102-key keyboards, extended keys are the Ins, Del, Home, End, Page Up, 
Page Down and arrow keys in the clusters to the left of the numeric keypad; and the divide (/) and 
Enter keys in the numeric keypad.  The location and arrangement of extended keys may vary from one 
keyboard to another and may not match the graphic keyboard display. 

Type a Key Sequence 

If this button is clicked, a Type a Key Sequence window will pop up.  In this window, you may type the 
key sequence you desire to map to the currently selected name in the list box.  On your acceptance of the 
typed key sequence, the key will automatically be mapped. 

Set Key Assignment 

This button sets the mapping of the currently selected key to the selected graphic keyboard keys. 

Undefine Key 

This button is used to remove the mapping of a key.  You may remove a mapped key by first selecting the 
key in the list box followed by a click of this button. 

Default 

This button loads the default keyboard layout as distributed by KMSYS Worldwide, Inc. 

Import 

Use this button to import an existing keyboard definition file (.KEY). 

Export 

Use this button to save the current keyboard layout to a file. 

Print 

Click this button to print a list of all key actions and key action assignments.   
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How to Map or Re-Map UTS Terminal or a HGS Client  Key 

The following describes the procedure for re-mapping UTS terminal or HGS Client keys: 

1. Select the key to be re-mapped from the list box shown. 

2. There are two methods of defining which key or key combination to map to the selected name in 
the list box: 

a. Click the Type Key Sequence button, and then type the desired key sequence directly 
on your keyboard.  When you accept the key sequence, the key mapping will 
automatically be set. 

b. Select the desired key from the graphic keyboard using a left mouse click over the face 
of the key.  Next, select the desired Shift, Alt and Ctrl keys, if any, by clicking them 
with the mouse.  Finally, to set the keys selected, click the Set Key Assignment 
button. 

These steps may be repeated until all desired key mappings are completed. 

Conflicts 

If a selected key sequence is already mapped to another key, a message box will appear naming the 
mapped key.  You may then re-map or "undefine" the key in conflict or choose a different key sequence. 

If you map a key that already has a key sequence assigned to it, a window will appear allowing you to 
Add an alternate key sequence, Redefine (replace) the existing key sequence with the new key sequence 
or Cancel the key assignment operation altogether. 

Add or Redefine Key 

The Add or Redefine Key window appears when a conflict is discovered while attempting to assign a 
keystroke or keystroke combination to a keyboard function. 

Help 

Click this button to receive on help for this window. 

Add 

Click this button to add an alternate key sequence.  This choice is useful when you want more than one 
keyboard key to perform the same function (e.g., the two Enter keys). 

Redefine 

Redefine or replace the existing key sequence. 

Cancel 

Clicking the Cancel button closes this window without assigning the key. 

HGS Macro Manager 

This dialog is used to maintain key macros.  Key macros may consist of any UTS key function, standard 
Windows cut/copy/paste, text strings, text strings with user prompts, timed waits and conditional waits for 
strings.  Macros may be created initially within the macro editor or with the macro recorder from any open 
screen. 

Graphic Keyboard 

The graphic keyboard display illustrates the configured key or key combinations assigned to activate a 
macro.  Note: The location and arrangement of the keys on the graphic keyboard may not match the 
exact layout of your keyboard; however, most keys on your keyboard should have its corresponding key 
represented on the graphic keyboard.  After selecting a macro name from the Available Macros list, the 
configured key or key combinations will appear as if they have been pressed (light gray).  You may 
change (redefine) or add additional key combinations by pressing the key(s) on the graphic keyboard with 
a left mouse click.  Valid key combinations are any single key plus one or more of the optional, Shift, Alt 
and Ctrl keys.  When the desired key combinations have been selected, press the Set Assignment 
button to assign the key. 
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Note:  Pressing the Num Lock key on the actual keyboard will cause the Num Lock display on the 
graphic keyboard to toggle (ON/OFF) and the captions on the faces of the numeric keypad keys to change 
accordingly. 

For enhanced 101- and 102-key keyboards, extended keys are the Ins, Del, Home, End, Page Up, 
Page Down and arrow keys in the clusters to the left of the numeric keypad; and the divide (/) and 
Enter keys in the numeric keypad.  The location and arrangement of extended keys may vary from one 
keyboard to another and may not match the graphic keyboard display. 

The extended keys may be mapped to any macro in the Available Macros list.  If they are not mapped, 
their behavior will be the same as their counterparts on the numeric keypad and main keyboard. 

Available Macros 

This list box contains the names of all configured key macros.  Each macro can have an activation key(s) 
assigned by pressing the keys on the graphic keyboard, followed by the Set Assignment button, or via 
the Type Sequence button. 

New Macro 

Click this button to create a new macro.  Hint: You can easily create a new macro by using the macro 
recorder on the HGS Client emulator window.  See the Start Recorder selection on the Macros menu. 

Edit Macro 

After selecting a macro from the Available Macros list, click this button to edit or view the macro with 
the Edit Macro dialog. 

Delete Macro 

After selecting a macro from the Available Macros list, click this button to delete the macro. 

Show in Menu 

Use this button to toggle between placing the selected macro on the Macros menu and removing it from 
view. 

Type Sequence 

If this button is clicked, a Type a Key Sequence window will pop up.  In this window, you may type the 
key sequence you desire to map to the currently selected name in the Available Macros list.  On your 
acceptance of the typed key sequence, the key will automatically be mapped. 

Set Assignment 

This button sets the mapping of the currently selected Available Macros to the selected graphic 
keyboard keys. 

Clear Assignment 

This button is used to remove a key mapping.  You may remove a mapped key by first selecting the key in 
the Available Macros list followed by a click of this button. 

How to Assign a Macro Activation Key 

The following describes the procedure for assigning macro activation keys: 

1. Select the key to be remapped from the Available Macros list box. 

2. There are two methods of defining which key or key combination to map to the selected name in 
the Available Macros list: 

a. Click the Type Sequence button, then type the desired key sequence directly on your 
keyboard.  When you accept the key sequence, the key mapping will automatically be 
set. 

b. Select the desired key from the graphic keyboard using a left mouse click over the face 
of the key.  Next, select the desired Shift, Alt and Ctrl keys, if any, by clicking them 
with the mouse.  Finally, to set the keys selected, click the Set Assignment button. 

These steps may be repeated until all desired activation keys have been assigned. 
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Conflicts 

If a selected key sequence is already mapped to another key (macro activation key or terminal function), 
a message box will appear naming the mapped macro or terminal function.  You may then re-map or 
remove the Available Macros in conflict or choose a different key sequence. 

HGS UTS Printer Configuration 

The Device Id tabs on the HGS UTS Printer Configuration dialog is used to assign printers to device ids 
(DIDs).  All printer settings are global for all HGS Client Session screens.  That is, you cannot configure 
different printers for each screen. 

Device Id. (DID) tabs 

Select the button (1-3) to be associated with the selected printer, below. 

Printer Output Type 

The options in this group allow you to choose one of two types of printing. 

Windows (Windows drivers) 

Select this option (the default) to print to a printer using the standard Windows print drivers. 

Passthru Printing (to Port) 

Select this option if the selected printer is to be used for passthrough printing. 

Local Print Object 

Select this option to use a user-developed LPO to receive print data instead of standard HGS 
Client print handling. 

See HGS Local Print Objects for the list of methods that may be referenced in the LPO. 

Windows Printing Settings tab 

Use the controls in this group to select a printer and printer attributes. 

Select Printer 

Select a printer from this drop-down list box.  This box contains a list of all printers installed 
through Windows on your PC.  If the Passthru Printing option is selected, this will be to only 
selection available on this tab. 

Printer Font 

The controls in this group affect the font used for printing. 

Font Name 

From this drop-down list box, select an installed font for printing. 

Size 

With this spin box, choose the appropriate font size. 

Bold Face 

Check this box if the print font is to be in boldface type. 

Character Set 

From this drop-down list box, select the desired character set. 

Orientation 

The mutually exclusive options in this group specify the page orientation to be used when 
printing. 

Portrait 

Choose this option to print so that the short edge is the top of the page. 

Landscape 

Choose this option to print so that the long edge is the top of the page. 
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Passthru Printing Settings tab 

The Passthru Printing Settings tab has controls that may be in effect when passthrough printing is 
chosen. 

Passthrough printing prints directly to a printer and may be useful in situations where the page oriented 
nature of Windows print management conflicts with the non-page orientation of some older TIP 
applications. 

Whenever possible, you should print using standard Windows print management (the default).  Windows 
controls all page formatting based on property settings for a configured print driver on your PC.  In this 
instance, the host application must not send any page control commands (i.e., form feeds) to the printer. 

When you bypass Windows print management and print directly to a printer, the host application program 
must supply all page control.  HGS Client simply passes all information directly through to a configured 
printer. 

Note:  The controls on this tab have no effect unless the Passthru Printing option is selected from the 
Printer Output Type group. 

Print Direct Options 

The options in this group control special line and form advancement. 

Send LF after CR 

Check this box to tell HGS Client to use CR LF at the end of a line. 

Send CR after LF 

Check this box to tell HGS Client to use LF CR at the end of a line. 

Send CR after FF 

Check this box to tell HGS Client to use FF CR at the end of a line. 

Send FF on Close 

Check this box to tell HGS Client to insert a FF at the close of the print. 

Send LF at End of Screen 

Check this box to tell HGS Client to add a LF at the end of each screen. 

Note: This box should not be checked when using MAPPER AUX because MAPPER 
includes an LF at the end of the screen (you would get one more line). Send LF at End 
of Screen is for transactions that do not put in an LF, thus causing the next screen's 
data to print starting at the end of the last line. 

Send FF at End of Screen 

Check this box to tell HGS Client to add a FF at the end of each screen. 

Note: This will send a Form Feed at the end of each screen or block from the host.  If 
the host message does not include an EOMI status, this action is not taken, allowing 
data from multiple screens to be printed without the form feed. 

No Auto-close Print 

Check this box to tell HGS Client to keep the print open at the end of a print operation. 

No Auto Page Feed 

Check this box to tell HGS Client not to perform a page eject after printing. 

Character Translations 

The entries in this table may be used to specify the ASCII characters that HGS Client is to 
substitute when receiving special ASCII characters from the host. 

Host Char. 

In this column, enter the decimal representation of the anticipated ASCII host character. 
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Print Char. 1 through Print Char. 4 

In these columns, enter the decimal representation of the ASCII replacement 
character(s) to be sent to the printer. 

Example of translating the tilde (~) to the Esc character: 

Host Print 
Char Char 1 

126 27 

Note: If additional rows are needed for translation, press the right-mouse button over 
the table and select Add Row from the drop-down menu with the left mouse button.  
The new row will be inserted at the bottom of the table.  The Delete Row item on the 
drop-down menu may be used to delete a selected row. 

Printer Start and End Strings (max 41 chars) 

The entries in this box can be used to provide special starting and ending strings to be sent to the 
certain printer devices.  Up to 41 characters may be supplied for each string. 

Start String 

In this row, enter the decimal representations of the ASCII characters to be sent to the 
printer as a beginning string. 

End Scrn Str 

In this row, enter the decimal representation of the ASCII characters to be sent to the 
printer as an ending string at the end of each screen (when no EOMI present).  If the 
End Screen string is present, the Send LF at end of screen and Send FF at end of screen 
are ignored. 

End String 

In this row, enter the decimal representations of the ASCII characters to be sent to the 
printer as an ending string. 

Local Print Object tab 

The controls in this group will be visible when the Local Print Object check box is checked. 

Local Print Object Class Name 

In this text box, enter the class name of the registered LPO or press the Browse button to 
search through all OLE Automation Servers registered with Windows. 

User Option 

In this text box, enter any required user options. 

Local Print Objects 

Local Print Objects (LPOs) are user-written OLE Automation Servers used in place of standard HGS Client 
terminal print handling to provide custom printing capability.  LPOs may be developed in any language 
that supports the development of OLE Automation Servers (e.g., C++, Delphi, etc.). 

LPOs may be developed whenever it is necessary to interpret screen print data in a manner other than it is 
presented on the terminal screen or sent from the host program. 

Local Print Object Interface Specifications 

Local Print Objects must adhere to the following interface specifications: 

LPO_Initialize 

LPO_Initialize is called once just before the first call to LPO_Open.  This method is provided to allow the 
LPO to perform any one-time initialization. 

Format: 

Function LPO_Initialize (Options as Integer) as Integer 
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Options is the contents of the User Options entry on the printer device setup configuration.  The LPO 
developer defines the content and use of this parameter.  The emulator does not use or modify it in any 
way. 

The LPO_Initialize function must return the Window Handle of the LPO's main window if successful, or a 
zero if not successful.  A Windows WM_Close message is posted to the LPO's main window using this 
handle when the UTS screen is closed.  This action is done to close the LPO automatically when its client 
UTS screen is closed. 

LPO_Open 

LPO_Open is called whenever the emulator opens the printer. 

Format: 

Function LPO_Open (ScreenRows as Integer, ScreenColumns as Integer) as Integer 

The emulator passes the screen size of the current screen in the ScreenRows and ScreenColumns 
parameters. 

The return value must be a 1 or 0 indicating success or failure, respectively. 

LPO_PrintData 

LPO_PrintData is called whenever the emulator receives a screen print command.  The command can 
come from the host or the keyboard. 

Format: 

Function LPO_PrintData (ScreenData as WideString, ScreenAttributes as WideString,  
CursorRow as Integer, CursorColumn as Integer, Flags as Integer 

ScreenData and ScreenAttributes are passed as WideStrings, but are used as arrays of word (unsigned 
16-bit integers).  

The ScreenData array contains ALL characters in the screen.  Double-byte characters are ORed with 100 
hex for the lead byte and 200 hex for the trailing byte. 

ScreenAttributes contains the attribute flags associated with the corresponding screen character.  
Attributes are defined as follows: 

The Flags parameter indicates the type of terminal print function requested.  For HGS Client, 
Flags are defined as follows: 0 = Print, 1 = Print Form, 2 = Print Transparent, 4 = Print Screen 
All. 

The return value must be a 1 or 0 indicating success or failure, respectively. 

LPO_Close 

LPO_Close is called whenever the emulator closed the current print operation. 

Format: 

Function LPO_Close as Integer 

The return value must be a 1 or 0 indicating success or failure, respectively. 

LPO_Show 

The emulator does not currently call LPO_Show. 

Format: 

Function Show (Options as Integer) as Integer 

The Options parameter is not yet defined.   

The return value must be a 1 or 0 indicating success or failure, respectively. 
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Application Color Scheme Preferences 

The Application Color Scheme Preferences window contains controls that affect the appearance of the 
HGS Client application.   

Selection on this window does not affect the appearance of the screen portion of an opened session.  
Unlike color selections set for emulation screens, application colors will be affected by any changes that 
have been made to the Windows System Colors. 

Schemes 

From the drop-down list box, select from one of seven pre-configured schemes from KMSYS Worldwide or 
from a scheme created by you.  The preconfigured schemes marked as, "(Preset)", may not be altered but 
may be selected and become the basis of a new scheme created by you (see the New Scheme button. 

New Scheme 

Click this button to create (name) a new application scheme.  Note: Whatever scheme is selected 
from the drop-down list box will be the basis of the new scheme. 

Rename Scheme 

Click this button to rename a selected scheme.  "(Preset)" schemes may not be renamed. 

Delete Scheme 

Click this button to delete a selected scheme.  "(Preset)" schemes may not be deleted. 

Button Effects 

The controls in this group determine the appearance of buttons on the HGS Client application. 

Select Button Color Effects 

Use the buttons in this group in conjunction with the Select Color button to change the colors of 
buttons and the colors displayed on mouse flyover. 

Normal Background 

Click this button followed by the Select Color button to change the background color of 
non-selected buttons. 

Normal Text 

Click this button followed by the Select Color button to change the color of text on non-
selected buttons. 

Normal Border 

Click this button followed by the Select Color button to change the color of the border 
surrounding non-selected buttons. 

Flyover Background 

Click this button followed by the Select Color button to change the background color of 
buttons when the mouse cursor is moved over the button. 

Flyover Text 

Click this button followed by the Select Color button to change the text color that will 
appear when the mouse cursor is moved over a button. 

Flyover Border 

Click this button followed by the Select Color button to change the border color that will 
appear when the mouse cursor is moved over a button. 

Selected Background 

Click this button followed by the Select Color button to change background color of a 
selected button. 

Selected Text 

Click this button followed by the Select Color button to change the text color of a 
selected button. 
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Selected Border 

Click this button followed by the Select Color button to change the border color of a 
selected button. 

Flyover Sel Background 

Click this button followed by the Select Color button to change the background color of 
a selected button when the mouse cursor is moved over the button. 

Flyover Sel Text 

Click this button followed but the Select Color button to change the text color of a 
selected button when the mouse cursor is moved over the button 

Flyover Sel Border 

Click this button followed by the Select Color button to change the border color of a 
selected button when the mouse cursor is moved over the button 

Select Color 

Use this button to change color after selecting a button effect from the Select Button Color 
Effects button group. 

Use Standard Windows Look 

Standard look will make buttons and panel look like the standard windows controls.  If XP themes 
are used, buttons will have themes applied. 

Note: When this box is checked, changes made using other color controls on this dialog will not 
be evident in the HGS Client application; i.e., checking this box overrides all other color 
selections for the application.  Screen color selections are unaffected by this option. 

Use 3d Button Effect 

If this box is checked, all buttons will have a three-dimensional appearance.  If the box is not 
checked, buttons will have a flat appearance. 

Form Color Preview 

All controls in this group are for preview purposes only. 

Panel Title Text 

The background and text in this title are affected by selections made with the Panel Title Color 
and Panel Title Text Color buttons in the Window Effects group at the bottom of this dialog. 

Sample Button 

The appearance of this button can be altered by any of the controls in the Button 
Effects group to the left of this preview panel. 

Sample Selected 

When this box is checked, the Sample Button will appear as determined by the bottom 
six buttons in the Select Button Color Effects; unchecked, the top six determine the 
effect. 

Panel Text 

Panel text and panel background are set using the Panel Text Color and Panel Color 
buttons, respectively. 

Window Effects 

The six buttons in this group let you set the color scheme for the windows, panels and text displayed in 
the HGS Client application.  For button colors, see above. 

Window Color 

This button determines the background color of the HGS Client window. 
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Window Text Color 

This button determines the color of any text appearing on the HGS Client window.  It does not 
affect panel or button text. 

Panel Color 

Use this button to alter the background color of a panel. 

Panel Text Color 

Use this button to change any text found on a panel. 

Panel Title Color 

This button may be used to alter the background color of panel titles. 

Panel Title Text Color 

Use this button to alter the text color of panel titles. 

Set to Defaults 

This button may be used to reset button and window color defaults according to the way they are defined 
in Windows. 

Apply 

Use this button to apply any changes immediately without exiting this window. 

OK 

Use this button to accept changes and exit the window. 

Cancel 

Use this button to reject any changes and exit the window. 

 

Application Color Selector 

The color selections on this window are divided into three groups: A basic 40-color set, the standard 
Windows 27 System Colors and a custom color area for gradient color selection.  There is also a list box of 
System Colors by Name for selection. 

Note: System Colors changed from the Windows Control Panel will affect the System Colors made 
available on this window. 

Std. Color Dialog 

Click this button to use the traditional Color dialog for selection. 

Apply 

Click this button to apply any changes without exiting the selection dialog. 

OK 

Click this button to accept any changes and exit the window. 

Cancel 

Click this button to discard any changes and exit the window. 
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Editing Macros 

Edit Macro 

The Edit Macro window is used to create and edit a string of successive keystrokes, waits and conditions 
that can comprise a macro. 

Key Macro Name 

In this text box, enter the name of the macro as it will appear on the Macros menu or macro bar. 

Macro Function List 

This list box contains a serial list of keystrokes, timed waits, prompts and wait conditions that can be 
included in a key macro.  Select from this list when replacing, deleting or moving a function in the list. 

Add 

Click this button to reveal a drop-down menu containing six different types of functions that may be 
included in the macro. 

Terminal Key Function 

Make this selection to bring up the Select Terminal Key Function window where a single UTS or 
HGS Client terminal keystroke (e.g., SOE, XMIT, CLIPBOARD_COPY, etc.) may be selected. 

Text String 

Make this selection to initiate the Text String dialog used to enter a string of text in the macro. 

Text String Prompt 

Use this selection to place a user prompt dialog in the macro.  The selection displays the Edit 
Prompt for Text window where a user prompt string may be entered.  When the macro is run, the 
dialog will be displayed with the user prompt, querying the user to enter a text string.  

Cursor Position 

Use this selection to place the cursor at a particular row and column.  This selection displays the 
Position Cursor dialog where the row and column may be entered. 

Timed Wait 

Make this selection to specify that the macro should wait for a period of time.  The selection 
displays the Timed Wait window where the pause time is specified in seconds. 

Wait for String 

Select this item to insert a conditional wait in the macro.  The ensuing Wait for String dialog 
allows you to specify a search string, the location of the search string on the screen, an equal or 
not equal operator and a timed wait value. 

Replace 

After selecting a function from the Macro Function List box, click this button to replace the function with 
a different function, or edit the selected function.  This button drops down the same selection menu as 
described for the Add button (see above). 

Delete 

After selecting a function from the Macro Function List box, click this button to delete the function from 
the macro. 

Move Up 

Press this button to move the selected function up in the macro. 

Move Down 

Press this button to move the selected function down in the macro. 

Revert 

Clicking this button will revert any changes to the macro since the dialog was opened. 
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OK 

Click this button to accept the changes to the macro and close the window. 

Cancel 

Click this button to discard any changes and close the window. 

Edit Prompt for Text 

This window allows a user prompt to be entered and placed in the macro. 

Enter User Prompt 

In this text box, enter the prompt to be displayed when the user is asked to enter a text string. 

Password Entry 

Check this box to password protect the text entered by the user.  Password protection causes asterisks (*) 
to be displayed in the text box as the user enters the text string. 

OK 

Click this button to accept the entries and close the window. 

Cancel 

Click this button to discard the entries and close the window. 

Position Cursor 

This window allows you to position the cursor to a location on the screen. 

Column 

In this text box, enter the column to place the cursor. 

Row 

In this text box, enter the row to place the cursor. 

OK 

Click this button to accept the entries and close the window. 

Cancel 

Click this button to discard the entries and close the window. 

Select Terminal Key Function 

This window allows the entry of single UTS terminal key or HGS Client key functions into the macro. 

Type List Search String 

In this text box, enter a partial or full terminal key function name.  Type only enough of the name to 
highlight the desired key function in the key function list box below this list box. 

OK 

Click this button to select the highlighted key function. 

Cancel 

Click this button to cancel the selection process. 

Text String 

This window allows the macro developer to enter a string of text in the macro. 

Enter a Text String 

In this text box enter the text string.  The string of text will be inserted at the current cursor position on 
the screen. 

OK 

Click this button to accept the text entry and close the window. 
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Cancel 

Click this button to discard the entry and close the window. 

Timed Wait 

This window allows the entry of a pause in the execution of the macro.  The timed wait is useful when 
communications is slow and a large amount of processing from the host occurs before returning control to 
the terminal screen. 

Enter Wait Time in Seconds 

In this text box, enter the number of seconds the macro is to wait before resuming processing of the next 
macro function. 

OK 

Click this button to accept the entry and close the window. 

Cancel 

Click this button to discard the entry and close the window. 

Wait for String 

This window allows a conditional wait to be placed in the macro.  The macro will wait for the presence or 
absence of a string returned from the host. 

String Value 

In this text box, enter the string to look for on the screen.  The value entered is case insensitive. 

String Location 

This group allows the location on the screen of the anticipated text string. 

When choosing the location on the screen to test for a string, you should be aware of the sequence of 
events that occurs, before the macro gets control to do the testing.  For example, in DEMAND mode, most 
output received from the host is painted on the next to last line of the terminal display.  Before control is 
returned to the macro, a CURSOR TO HOME and DELETE LINE is issued, thus moving the output to two 
lines from the bottom of the display.  Thus, on a 24-line display, testing should be performed on row 22, 
not row 23. 

Row 

In this text box, specify the row where the beginning of the string is expected. 

Relative to Current Row 

If this box is checked, the value entered in the Row text box is relative to the current row of the 
cursor. 

Column 

In this text box, specify the column where the beginning of the string is expected. 

Relative to Current Column 

If this box is checked, the value entered in the Column text box is relative to the current column 
of the cursor. 

Any position in Entire Screen 

Check this box to look for the string beginning at any position on the screen. 

Wait for String To Be 

This option group is used to specify if the condition checked for is true or false. 

Equal = 

Select this option to check for an equal condition. 

Not Equal <> 

Select this option to check for a not equal condition. 
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Wait Time (seconds) 

In this text box, enter the number of seconds to wait before failing the test.  In other words, this is the 
interval of time to wait for the presence (=) or absence (<>) of the anticipated string.  When this time is 
exceeded, a time-out message box will appear during macro execution. 

OK 

Click this button to accept the entries and close the window. 

Cancel 

Click this button to discard the entries and close the window. 

 

Macro Screen Control Sequence 

This window allows you to add UTS control sequences to a macro.  Consequently, control sequences can 
be passed directly to the screen, thus allowing control page updates or setting FCCs in the screen. 

Control Sequence 

This box contains a string of "characters" that make up a UTS control sequence. 

Control characters are always entered as symbolic names enclosed within angle brackets *<>".  If a "<" 
character is needed, it can be entered as "<<>".   The Control Char Symbols drop-down list box and 
the Add Ctl. Char button may be used to select control characters or they may be typed directly (encased 
in angle brackets) into the Control Sequence text box. 

The following Control Sequence moves the cursor to the home position, clears the entire screen then sets 
up an FCC field with video off to allow hidden entry of a user id and password: 

<ESC>e<ESC>m<US>  E@ 

The user id and password would be entered with the TEXT function. 

The following sequence would restore video on: 

<ESC>e<ESC>m<US>  D@ 

Control Char Symbols 

Select a symbol from this drop-down list box and click the Add Ctl. Char button to insert the control 
character into the Control Sequence text box. 

Add Ctl. Char 

Click this button to insert the selected control character into the Control Sequence text box. 

OK 

Click this button to accept the entries and close the window. 

Cancel 

Click this button to discard the entries and close the window. 
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How to... 

Selecting with the Mouse 

All selections discussed in this section are made with a single click of the left mouse button.  For example 
the instruction, "select Print Screen (All) from the File menu," implies that the following actions should 
be taken: 

1. Move the mouse cursor over the word, File, on the menu bar. 

2. Click the left mouse button once to reveal the menu. 

3. Move the mouse cursor over the Print Screen (All) selection. 

4. Press the left mouse button again to complete the instruction. 

Note: Left and right-mouse button actions may be reversed (run the Mouse icon/program in the Windows 
Control Panel). 

Many of the menu selections also have corresponding buttons.  These buttons are conveniently located on 
a toolbar immediately below the menu bar.  These buttons represent the more frequently executed HGS 
Client commands or selections. 

A right-mouse click over any portion of the screen will drop down an edit menu of frequently used 
commands. 

Where appropriate, shortcut keys are shown in parentheses and toolbar buttons are shown in the right 
margin of the on-line help. 

Configuring UTS Keys 

To change an UTS key, follow this procedure: 

1. Select User Configuration Manager from the File menu of the HGS Client UTS Screen 
window.  

2. Click the Keyboard button on the HGS UTS User Configuration Manager window. 

3. Select a key from the UTS Terminal Keyboard Key Names list box. 

4. Press the desired key or key combination (any key plus Alt, Ctrl and/or Shift) on the visual 
keyboard. 

5. Press the Set Assignment button. 

6. If a key is already defined, a message window will appear allowing you to replace 
(Redefine) the existing definition or Add an additional definition. 

7. Press the OK button. 

Creating and Maintaining Key Macros 

A key macro is a series of keystrokes and functions that when strung together perform frequently used, 
repetitive tasks.  The simplest way to create a new macro is to use the macro recorder.  Once the initial 
macro has been created, it can be tailored to your needs with the Edit macro feature of the HGS Client 
Configuration Manager. 

Take, for example, a macro that will initially edit an element in a program file, but will be modified later to 
prompt the user for the file, element and version name. 

To initially record the macro: 

1. Select Start Recorder from the Macros menu on a HGS Client UTS Screen. 

2. Perform your 2200 task as usual.   

In the example mentioned above, an SOE is typed followed by the IPF processor call and a 
few IPF commands as follows: 
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@ipf pf. 

IPF 1100  6R3 12/09/98 16:45:25  

~C~ old element  

~C~ mode screen 

3. Select Stop Recorder from the Macros menu. 

4. In the Save Key Macro window that appears, give the macro a name in the Key Macro 
Name text box and press the OK button. 

To modify the macro: 

1. Select User Configuration Manager from the File menu. 

2. Click the Macros button on the HGS UTS User Configuration Manager window. 

3. Select the desired macro from the Available Macros list box and click the Edit button. 

4. In the Edit Macro window, add, replace, delete or move functions from the Macro Function 
List box with the button controls on the right of the window.  Note: The Add button will add 
a function above the selected function in the Macro Function List box 

When the macro recorder was executed, HGS Client inserts a WAIT for 2 seconds at the 
beginning of the macro and after each TRANSMIT KEY.  These waits are used to pause for a 
period of time, thus giving the host time to process the information transmitted to the host 
and respond.  Some of the waits may be decreased or even deleted while others may need 
to be increased depending upon the speed of communications and the amount of time for the 
host to respond. 

In the example, we will replace the WAIT at the beginning of the macro with an ERASE 
DISPLAY, a WAIT 1, a CURSOR TO HOME and an ERASE DISPLAY. 

The “@IPF PF.” text string will be replaced with “@IPF “ followed by the text string prompt, 
“Enter file name.” 

The “old element” will be replaced with "old " followed by the text string prompt, “Enter 
element/version.” 

5. 5. Click the OK button to complete the modification. 

To add the macro to the Macros menu or the Macro button bar: 

1. Select the desired macro from the Available Macros list box. 

2. Click the Set/Clear Show Macro Button on Macro Bar button and/or the Set/Clear 
Show Macro in Menu Option button (the two buttons above the Revert button). 

To add a key sequence to activate the macro from the keyboard: 

1. Select the desired macro from the Available Macros list box. 

2. Press the Type Sequence button. 

3. Strike the key combination you wish to use as the activation key sequence. 

4. Click Yes on the Confirm Activation Key window. 

5. Press the OK button to exit the configuration program. 

Applying Colors and Fonts to Specific Screens 

You may change the appearance of the text displayed on the HGS Client screen by selecting from a list of 
screen fonts installed on your system.  Colors may be applied based on field attributes displayed on the 
screen.  To change the screen’s font and or color, follow this procedure: 

1. Select User Configuration Manager from the File menu.  

2. Click the Appearance button. 
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3. For font changes, click the Screen Font button. 

4. Select the desired font and font sty 

5. Press the OK button on the Font window. 

6. For color changes, select a field attribute from the option buttons in the Select Color for 
Attribute option group.   

7. Next, select the foreground (text) and background colors from the two drop-down list boxes 
provided. 

8. Repeat Steps 6 and 7 for each attribute required by your host application. 

9. Press the OK button on the HGS UTS User Configuration Manager window. 

Adjusting Font, Font Sizing and Spacing 

Six HGS Client selections allow you to control how the text in the HGS Client window will appear on your 
monitor.  All six selections may be found by selecting Screen and Font Settings from the Options 
menu.  A window will appear showing six controls: 

1. Select from the Available Fonts drop-down list box to change the screen font. 

2. Check the Bold box if you want to increase the intensity of the select font to bold. 

Note:  The next four buttons will only be visible when the auto-scale mode is not Font to Screen 
(see Appearance). 

3. The A+ button increases the font size by one point and automatically increases the screen size 
accordingly (see Font Limitations).  If the font/screen size becomes too large to be 
accommodated within the confines of your display, scroll bars will appear to the right and at the 
bottom of the screen.  These scroll bars guarantee you access to all data displayed. 

4. The A- button decreases the font size by one point. 

5. You may expand the amount of space between lines of text by using the button with arrows 
pointing away from each other. 

6. To reduce the amount of space between lines, use the button with arrows pointing toward each 
other.  Warning: If you decrease the spacing too much, certain letters in the se font may not be 
readable. 

Using Mapper "Look and Feel" 

A useful option of HGS Client is the Mapper "Look and Feel" feature.  In general, this feature provides a 
graphical look to the Mapper user and gives function-key-capability when using the mouse.  The Mapper 
“Look and Feel” feature was first implemented in Mapper level 35, but is not necessarily limited to Mapper 
users only.  The feature may also be useful in any host application that supports the feature (e.g., DPS 
applications).  To use the Mapper “Look and Feel” feature, follow this procedure: 

1. Select User Configuration Manager from the File menu of the HGS UTS Screen window.   

2. Set the Mapper look check box. 

3. Press the OK button. 

For more on the display characteristics and restrictions of Mapper "Look and Fe see Mapper Look. 

Changing Screen Font 

You may change the appearance of the text displayed on the HGS Client screen by selecting from a list of 
screen fonts installed on your system.  To change the screen font, follow this procedure: 

1. Select User Configuration Manager from the File menu of the HGS UTS Screen window.   

2. Select the desired font, font style and size. 

3. Press the OK button. 
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Recall Recent Input 

On occasion, you may wish recall or retransmit a line of input to the host, and that line, no longer appears 
on the screen.  HGS Client retains a list of the 200 most recent lines sent to the host.  The following 
procedure outlines the steps required to use this feature: 

1. Position the cursor at the point on the screen where you wish the line to be repainted. 

2. Press Ctrl+Up Arrow (this key is configurable, see Keyboard) or select Input Recall 
(Ctrl+I) from the Edit window. 

3. With the mouse, select the desired line from the list box provided. 

4. Click the Transmit button to paint the line and transmit it to the host (double clicking the 
line will also cause a transmit).  If you wish to alter the line before transmitting, click on the 
Paste button. 

Note:  This feature is particularly useful when the recall line is lengthy and you wish to avoid having to 
retype the entire line. 

Using UTS Function Keys 

Many host applications support the use of UTS function keys.  HGS Client supports all 22 function keys 
(F1 through F22) that may be selected from the keyboard or with the mouse.  By default, HGS Client 
displays these keys in the form of buttons on a toolbar that may be selected with the mouse. 

Displaying HGS Client Keyboard Definitions 

At times, you may wish to perform standard UTS terminal functions through the keyboard such as ERASE 
TO END FIELD, TAB BACK, etc.  An easy way to see the keyboard key sequences required to perform 
these UTS terminal functions is through the display of the UTS Key Sequences window.  To view this 
window, click the Key List button on the HGS Client toolbar. 

Select any entry in the list box and press the OK button to execute the UTS function. 

Printing 

There are two forms of printing available in HGS Client: Printing an exact image of the entire screen and 
UTS screen printing (printing from the most recent SOE to the cursor). 

To print an exact screen image, follow this procedure: 

1. Select Print Screen (All) from the File menu (or Ctrl+P) or by using the corresponding 
button on the toolbar. 

To use the UTS screen-printing feature, follow this procedure: 

1. Select Print Screen (UTS) from the File menu (or Ctrl+U). 

2. Return to the host session and perform any host printing tasks (@@PRNT, Mapper AUX 
printing, etc.). 

Note:  The Ctrl+P and Ctrl+U are the default key combinations used for printing with HGS Client; 
however, both may be reconfigured to other keys or key combinations (see Keyboard). 
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Miscellaneous 

Font Limitations 

The ability to increase/decrease font size by a single point only works properly when using scalable fonts 
like the True Type font, Courier New (installed with Windows).  Non-scalable fonts have a fixed number of 
point sizes available (e.g., 6, 9, 11, 14, etc.) and are missing several point sizes (e.g., 7, 8, 10, 12, 13); 
consequently, HGS Client will be unable to increment/decrement to the missing sizes.  To select a different 
font, follow this procedure: 

1. Select Screen and Font Settings from the Options menu.  

2. Select a font from the Available Fonts drop-down list box. 

3. Press the Save button to make the selection permanent. 

4. Press the Close button. 

Note: All of the True Type fonts are scalable. 

Technical Support 

If you are experiencing difficulties configuring HGS Client or are experiencing runtime difficulties, please 
consult the person responsible for maintaining communications at your site for assistance.  If difficulties 
persist, please contact the Technical Support Group at KMSYS Worldwide, Inc., through one of the 
following: 

E-mail – support@kmsys.com 
Internet – www.kmsys.com 
Telephone – (770) 635-6363 
Facsimile – (770) 635-6351 
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